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1 Introduction
This manual explains the installation, configuration and usage of the payment module for

OpenCart and First Cash Solution.

Before beginning with the installation, please make sure that you are in possession of all

necessary data:

You should have received a Merchant ID from First Cash Solution for the test account. 

Furthermore, you have received the corresponding user name and password

Encryption password and HMAC-Key

An Analytics Password which you require for logging into First Cash Solution Analytics

OpenCart payment module by sellxed.com/shop

Access data to your server and shop

In case you don't yet have a contract with First Cash Solution, you can gladly acquire it directly

through us.

Note that you must use at least PHP version 5.6 for our plugins. PHP 8 or higher is currently not

supported.

1.1 Process of the Installation

In this document you will find all important information for the installation of the module. It is

important that you strictly follow the checklist. Only by doing so, can a secure usage in

correspondence with all security regulations be guaranteed.
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1.  

2.  

3.  

4.  

5.  

Basic configuration of the server including the setting up of the notify script

Configuration of the basic settings of the payment module

Configuration of the payment methods

Carrying out of a test purchase with the attached  at the end of this documenttest data

If the test was successful, your account can be activated

Installation Service

Our payment plugins should have per default the correct settings for most of our

customers' preferences. That means once you have entered the required credentials in

the plugin configuration to connect your account to your website, the plugin should be

fully operational. Should you be willing to receive detailed information on a setting you

do not know, you may contact our support team who will be able to assist you further.

Our support team is at your disposal during regular business hours at: http://www.

. Furthermore, you have the option of ordering our installationsellxed.com/support

service. We will make sure the plugin is installed correctly in your shop: http://www.

sellxed.com/shop/de/integration-und-installation.html

.htaccess Directory Protection

In order to test the module, any kind of directory protection or IP blocking on your server

must be deactivated. This is crucial as otherwise the payment feedback of First Cash

Solution might not get through to the shop.

1.2 System Requirements

In general, the plugin has the same system requirements as OpenCart. Below you can find the 

most important requirements of the plugin:

PHP Version: 5.4.x or higher

OpenSSL: Current version with support for TLS 1.2 or higher.

fsockopen: The PHP function fsockopen must be enabled. The plugin must be able to 

connect to external systems over the Internet.

PHP Functions: All common PHP functions must be enabled.

In case you are using OpenCart version 3.0.3.5 or 3.0.3.6, you must patch your store to fix the twig

extension error in order for modified templates to be loaded. The following extension can be

used to resolve the issue: https://www.opencart.com/index.php?route=marketplace/extension

./info&extension_id=40469

http://www.sellxed.com/support
http://www.sellxed.com/support
http://www.sellxed.com/shop/en/integration-und-installation.html
http://www.sellxed.com/shop/en/integration-und-installation.html
https://www.opencart.com/index.php?route=marketplace/extension/info&extension_id=40469
https://www.opencart.com/index.php?route=marketplace/extension/info&extension_id=40469
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2 Configuration of the Payment Module and 
the Server
In order to perform the configuration of the  of OpenCart, the following informationmain module

is necessary. You should have received the information from First Cash Solution.

First Cash Solution Live Merchant ID

First Cash Solution Live Encryption Key

First Cash Solution Live Signature Passphrase

Enter the credentials directly inside the configuration of the . After you performedmain module

some test payments, you can switch between Live Mode and Test Mode.

2.1 Configuration of the Payment Module

For the usage of the gateway in your shop, fill in all received access data at its corresponding

place in the  and in the .main module payment methods

Hidden Mode

Please Note if you use hidden this poses additional PCI requirements to your shop that

have to be met. Get in touch with First Cash Solution to get additional information.

Also if you use Hidden in your Module please advise First Cash Solution that they are able

to configure your paynow settings accordingly.
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1.  

2.  

3.  

4.  

5.  

6.  

3 Module Installation and Update in the 
OpenCart Shop

3.1 Installation

At this time you should already be in possession of the module. Should this not be the case, you

can download the necessary files in your customer account in the  (Menu "Mysellxed shop

Downloads Downloads"). In order to install the module in your shop, please carry out the

following steps:

Download the plugin. The download can be found in your sellxed.com account under "My 

Downloads".

Unzip the archive you have just downloaded.

In the unzipped folder navigate to the folder "files"

For some shops there are different versions of the plugin provided. If this is the case open 

the folder which corresponds to your shop version.

Using your preferred FTP client upload  of this folder into the root directory entire content

of your shop. For some shops there is a specific folder containing the plugins. If that is the 

case upload the plugin into this folder. Make sure that the folders aren't replaced but 

merely merged.

If you haven't yet done so, log back into your shop.

3.2 Updates and Upgrades

You have direct and unlimited access to updates and upgrades during the duration of your

support contract. In order to receive constant information about available updates we ask you to

subscribe to our RSS feed that we publish for your module.

More information regarding the subscription of this RSS feed can be found under: http://www.

.sellxed.com/en/updates_upgrades

We only recommend an update if something doesn't work in your shop, if you want to use new

feature or if there is a necessary security update.

3.2.1 Update Checklist

We ask you to strictly comply with the checklist below when doing an update:

https://www.sellxed.com/shop/en/customer/account/login/
http://www.sellxed.com/en/updates_upgrades
http://www.sellxed.com/en/updates_upgrades
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1.  

2.  

3.  

Always do a backup for your database and your files in your shop

Use always a test system to test the update process.

Wait until all the files are copied to the shop, clear the cache if there is one in your shop 

and then visit the configuration page of the main module so that the update process will 

be initialized.

Do not do updates directly in the live environment

Please test the update procedure first in your test shop. Our support team is able and

willing to help you if you experience problems with the update process. However, if you

decide to perform the update directly in your live shop there is the possibility of a

downtime of the shop of more than two days depending on the availability of our support

if you do not want to book our .complementary support

Depending on the version it could be that the database has to be migrated. We recommend you

therefore, to perform the updates in times when the shop is not visited too frequently by your

customers.

3.2.2 Update Instructions

Please always read the update instruction. Those instructions can be found in the changelog. If

there are no special remarks, you can proceed by just overwriting the files in your system.

https://www.sellxed.com/shop/en/sellxed-zusatz-support.html
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4 Module Configuration in the OpenCart Shop
The configuration consists of two steps. The first step is the configuration of the main module

with all the basic settings (cf. . During the second step you canConfiguration of the Main Module)

then carry out individual configurations for each . This allows for full flexibilitypayment method 

and perfect adaptation to your processes.

Create backups!

Please create a backup of the main directory of your shop. In case of problems you will

then always be able to return your shop to its original state.

We furthermore recommend testing the integration on a test system. Complications may

arise with third party modules installed by you. In case of questions, our support is gladly

at your disposal.
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5 OpenCart 3.0 Installation - Additions
In order to guarantee smooth operations and the usage of all features please make sure that you

follow the instructions below.

5.1 Configuration of the Main Module

You will find the settings for the main module under "Extension > Modules > First Cash Solution

. Install the module by clicking .Base Module" Install

By clicking  you can configure the main module. Enter all data in the corresponding fields.Edit

Each option is, furthermore, explained in short info texts in the shop.

5.2 Configuration of the Payment Module

After having successfully configured the main module, you can find the settings for the individual

payment methods in your shop under . Each payment method is listedExtensions > Payments 

individually. Install the payment methods you wish to offer to your customers. You can carry out

individual settings for each payment method and thereby optimally adapt the payment methods

to your existing processes. The most central options are described in more detail further below.

By clicking on  the payment method is activated in your shop. Click  in order to modifyInstall Edit

the configuration of the payment method.

5.3 Direct Capturing of Transactions

The option "Capture" allows you to specify if you wish to debit payments directly or if you first

wish to authorise them and then debit the payment at a later point.

Depending on your acquiring contract, a reservation is only guaranteed for a specific period of

time. Should you fail to debit the payment within that period, the authorisation may therefore no

longer be guaranteed. Further information on this process can be found below.

Different settings between First Cash Solution and the module

It may be that settings saved in the payment modules overwrite settings saved in First

Cash Solution.

5.4 Uncertain Status

You can specifically label orders for which the money is not guaranteed to be received. This

allows you to manually control the order before shipment.
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5.4.1 Setting the order state

For each payment method you may select in which state the order should be set to depending on

the booking state. This is the initial state of the order.

5.5 Optional: Validation

Note: It can be that this option is not visible in your module. In this case just ignore this section.

With the option 'Validation' you can define the moment when the payment method should be

made visible to the customer during the checkout process. This setting is relevant for modules

where the usage depends on the customer's compliance with specific preconditions. For

example, if a solvency check has to be carried out or if the payment method is only available in

certain countries. In order for the credit check or address validation to also work with European

characters, the charset of the "Blowfish mode" must be set to "UTF-8" for certain PSP settings.

You have the choice between these options:

Validation before the selection of the payment method: A validation verification is carried 

out before the customer selects the payment method. If the customer does not fulfill the 

requirements, the payment method is not displayed

Validation after selection of the payment method: The verification of the compliance 

occurs after the selection of the payment method and before the confirmation of the order

During the authorisation: The validation verification is carried out by First Cash Solution 

during the authorisation process. The payment method is displayed in any case
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6 Settings / Configuration of Payment Methods

6.1 General Information About the Payment Methods

The plugin contains the most common payment methods. In case a desired payment method is

not included per default, please contact us directly.

In order to be able to use a payment method, it must be activated in your account with First Cash

Solution as well as in your shop. Information about the configuration of the payment methods

can be found further above.

Below you can find important information for specific payment methods that deviate from the

standard process.

6.2 Information on Payment Status

For each payment method you can define an initial payment status (status for authorized

payments etc.). You hereby define the payment status for each state depending on the

processing type of the order (captured, authorized, etc.). It's the initial status which the order

assumes. Depending on the mutation carried out by you, the status can change.

Important info regarding Order Status

Never set the status to  or any similar pending status which isPending First Cash Solution

implemented by the module.

6.2.1 Order status "pending" / imminent payment (or similar)

Orders with the status 'pending First Cash Solution' are pending orders. Orders are set to that

status if a customer is redirected in order to pay but hasn't returned successfully or the feedback

hasn't reached your shop yet (Customer closed window on the payment page and didn't complete

payment). Depending on the payment method these orders will automatically be transformed

into cancelled orders and the inventory will be cleared (so long as the Cronjob is activated). How

long this takes depends on the characteristics of the payment method and cannot be configured.

If you have a lot of pending orders it usually means that the notifications from your webserver to

First Cash Solution are being blocked. In this case check the settings of your firewall and ask the

Hoster to activate the IPs and User Agents of First Cash Solution.

6.2.2 Order status "cancelled"

Orders with the status "cancelled" have either been set to that status automatically due to a

timeout, as described above, or have been cancelled directly by the customer.
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6.3 Payment Methods

The modules differentiate between the standard and the professional version. In the

professional version, all payment methods available for First Cash Solution are integrated. With

the standard version, however, you only receive the most common payment methods. Should a

desired payment method not be available, please contact us directly.

6.4 MasterPass Integration: What to keep in mind

If you integrate MasterPass as a payment method in your shop, you have two integration options:

External and Standard Checkout. When using External Checkout, the customer does not have to

provide address data during checkout. The customer only needs a MasterPass account and the

data will be transmitted by MasterPass. In order to use this option as a merchant, you have to

activate this payment method with First Cash Solution.

Please keep in mind, that using additional functions such as address transmission through

MasterPass, may require the activation of the respective options through First Cash Solution

aktiviert.

In order to use MasterPass in compliance with the MasterCard guidelines, please read the

following information carefully before using this payment method.

6.4.1 Integration Possibilities for MasterPass

MasterPass can be integrated as a normal payment method with redirection to First Cash

Solution or as an external checkout.

6.4.1.1 MasterPass as a Payment Method

If you like to integrate MasterPass as a normal payment method, activate the payment method

as usual (see ). In this scenario the customer will first beConfiguration of the payment method

redirected to MasterPass and then to the wallet of the issuer.

6.4.1.2 MasterPass as External Checkout

If you integrate MasterPass as an external Chekout, you can minimize the steps towards the

payment radically. The adress transfer and the creation of the account is processed via

MasterPass. If you activate the external checkout, there appears a button in the basket with

which you can jump after the login directly to the last step of the order confirmation. The

creation of the account happens in the background.

For the activation of the external checkout go to Extensions > Modifications > Modules > First

. There you'll find all settings for the external checkout:Cash Solution Base Module > Edit > More 
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Figure 6.1: Activation of the external checkout.

MasterPass as external checkout is not for all cases available. If this point in the manual doesn't

appear, please make sure to contact us.

6.4.2 Checkout: MasterPass Learn More Button

When using MasterPass as a payment method for standard checkout, it is mandatory to link to

the MasterPass Learn More Page. In order to do this, navigate to .Payment Method Configuration

Paste the link for the Learn More Page into the field 'Description' for the respective languages.

The field 'Learn More' will now be displayed when choosing a payment method.

We have already collected the most important links for you. You only have to copy and paste the

links into the description field:

German:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/de/DE/" target="

_blank">Mehr Erfahren </a>

French:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/fr/FR/" target="

_blank">apprendre plus </a>

English: <a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/DE/" target="

_blank">Learn More </a>

Spanish:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/ES/" target="

_blank">aprender más </a>

Italian:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/it/IT/" target="

_blank">saperne di più </a>

Dutch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/nl/NL/" target="

_blank">Leer Meer </a>
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Figure 6.1: Example for entering a description (Magento). These settings are to be found in the 

payment method configuration for MasterPass.

Figure 6.1: The Learn More Page link should appear in the frontend.

Links for additional languages can be found in this document: https://developer.mastercard.

com/...

6.4.3 Additional information

General and additional information on using the MasterPass trademark and logo in your

webshop are available in the official MasterPass Mechant Branding Requirement Document.

which you can access here: https://developer.mastercard.com/...

https://developer.mastercard.com/portal/download/attachments/48234577/Masterpass+Digital+Assets+-+Buttons+Learn+More+Links+v6+09+19+2014.pdf
https://developer.mastercard.com/portal/download/attachments/48234577/Masterpass+Digital+Assets+-+Buttons+Learn+More+Links+v6+09+19+2014.pdf
https://developer.mastercard.com/portal/download/attachments/48234577/MasterPass+Branding+Guidelines+v2.0+_+09+19+2014.pdf
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7 The Module in Action
Below you will find an overview of the most important features in the daily usage of the First Cash

Solution module.

7.1 Useful Transaction Information on the Order

You can find an overview of the transaction information in within the order detail view. Among

others, this information allows for the definite attribution of the orders to their corresponding

transaction, seen in the backend of First Cash Solution.

Figure 7.1: Transaction Information in OpenCart.

7.2 Using Invoice Details of a Processor

In the following context you can view or embed the "payment details" of for example an "Open

Invoice" transaction:

7.2.1 OpenCart Order Confirmation (E-Mail)

The "payment information" will be visible in the default "order confirmation e-mail" of OpenCart.

7.2.2 OpenCart Invoice (PDF)

This feature is not available by default in OpenCart that`s why it can not be supported by the

payment gateway module.
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7.2.3 OpenCart-Backend (Transaction details)

You can view the payment and transaction details in OpenCart under Sales > First Cash Solution

. If you can not find this menu point you have to clear the OpenCart modificationsTransactions

under .Extensions > Modifications >

Figure 7.1: Transaction details within OpenCart.

7.2.4 OpenCart Success-Page

Due to technical limitations, it is currently not possible to display the "payment information"

here.

7.3 Usage of the Alias Managers / Token Solution

With the Alias Manager, your customers can securely save their credit cards with First Cash

Solution for later purchases. You can enable this by activating the option "Alias Manager" in the

configuration of the . The customer can then choose from his or her savedPayment Method

credit cards without having to re-enter all the details.
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Figure 7.1: Alias Manager

Alias Manager Options

The usage of the Alias Managers requires the activation of the correct option with First

Cash Solution. To do so, please contact the support directly.

7.4 Capturing / Cancelling of Orders

7.4.1 Capturing Orders

In order to capture orders, open the transaction manager under Sales > First Cash Solution

Transactions. Here you will find an overview of all transactions. Search for the order in the field

with the order numbers. By clicking "view" you will open the transaction of the order.

7.4.1.1 Capturing Complete Orders or Partial Capturing

By clicking the button "Capture Transaction" a new window opens up. You can now capture every

item individually in case you do not wish to send all items at once. The amount of possible partial

captures depends on your contract. Please contact First Cash Solution directly in order to clarify

questions.

Capturing of Orders in the backend of First Cash Solution

The transaction management between your shop and First Cash Solution is not

synchronised. If you capture payments with First Cash Solution, the status in the shop will

not be updated and a second capturing in the shop is not possible.

In case you do not wish to capture all items of an order, you can close the transaction by clicking

the box.
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Figure 7.1: Capturing of Orders

Partial Capturing

Please find out if the capturing of partial amounts is supported by your First Cash

Solution contract. If this is not the case, it might happen that the transaction is closed for

further transactions after a partial capture.

7.4.2 Cancel Orders

By clicking "Cancel Transaction", the transaction is  and the reserved amount on yourcancelled

customer's card is released automatically.

Figure 7.1: Capture or Cancel in OpenCart.

7.5 Refunding Orders

In order to refund orders, open the transaction information (cf. above).

You can refund individual items or any amount of your choice by modifying the total amount or

the item quantity.
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Figure 7.1: Refunds in OpenCart for First Cash Solution.

Maximal Refund

With our module it is not possible to refund more than 100% of the originally authorised

amount.

Executing a refund will not change the status of the order.

7.6 Setup a Cron Job to Activate the Timed Operations

To activate the timed operations of the plugin (e.g. update service, deleting pending orders, etc.)

make sure that you set up the OpenCart Cron engine. Especially the update function allows you to

automatically retrive additional information or changes of your order directly via the API of First

Cash Solution. Please note it could be that in order to use the update feature it may be necessary

that First Cash Solution activates additional options in your account.

In order to use the timed operations, please schedule a cron job in your server to the following

controller:

https://www.your-shop.com/index.php?route=fcsolutioncw/cron/cron

Here we suggest you use a Cron Engine like for example . That way you can This allowsEasyCron

you to open the file ( URL ) with an external service.

https://www.easycron.com?ref=39190
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8 Testing
Before switching from test to live mode it is important that you test the module extensively.

Testing

Do not forget to switch the operating mode from test to live after having successfully

tested the module.

8.1 Test Data

In the following section you can find the test data for the various payment methods:

Credit Card (Be2Bill)

Card number 5555555555554444

Expiry Date 12/2023

CVC 123

Mastercard

Card number 4000012892688323

Expiry Date 12/2020

CVC 123

Visa

Credit / Debit Card

Card number 5555555555554444

Expiry Date 12/2023

CVC 123

Mastercard

Card number 4000012892688323

Expiry Date 12/2020

CVC 123

Visa

Direct Debits

Direct

Last Name Wischnewski

First Name Hans-Jürgen

Birtday 1973-12-27

Street Müllerstraße 137

Postcode 13353

City Berlin

Country DE

Phone 03018425165

RatePay: B2C

Company Name Imperium UG

Sales Tax Number DE123456789

Last Name Descartes

First Name René

Birtday 1973-12-27

RatePay: B2B
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Street Odeonplatz 1

Postcode 80539

City München

Country DE

Phone 08945687541

BIC BYLADEM1ROS

IBAN DE36711500000009290701

InterCard: Accepted

Customer ID customer1

Company Must be empty

Gender FEMALE

Firstname Julia

Lastname Tester

Street Aalener Str. 57

Post Code 73492

City Rainau

Country DE

Phone 07361889969

E-Mail julia@tester.com

Birtday 1987-10-25

Paymorrow: Accepted

PayU CEE

Card number 4355084355084358

Expiry Date 12/2020

CVC 000

Visa

Invoice

Procedure

Use any valid German address. The 

first two attempts are succesful. The 

third will fail.

BillPay

Company Must be empty

Firstname Paul

Lastname Positiv

Street Teststr. 4

Post Code 49084

City Osnabrück

Phone 095198009

BillSAFE: Accepted

Test Data

http://developers.klarna.com/en

/testing/invoice-and-account

Klarna

Last Name Wischnewski

First Name Hans-Jürgen

Birtday 1973-12-27

Street Müllerstraße 137

Postcode 13353

City Berlin

Country DE

Phone 03018425165

RatePay: B2C
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Company Name Imperium UG

Sales Tax Number DE123456789

Last Name Descartes

First Name René

Birtday 1973-12-27

Street Odeonplatz 1

Postcode 80539

City München

Country DE

Phone 08945687541

RatePay: B2B

8.2 Testing - First Cash Solution Simulation Mode

Any kind of payment method can be tested with our modules. The "Operation Mode" corresponds

to the simulation mode with First Cash Solution. Payments with a total of less than 10'000 EUR

are always accepted.
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9 Errors and their Solutions
You can find detailed information under . Should you not be ablehttp://www.sellxed.com/en/faq

to solve your problem with the provided information, please contact us directly under: 

http://www.sellxed.com/en/support

9.1 The Referrer URL appears in my Analytics Tool

When a customer and the notification are redirected via Header Redirection, the First Cash

Solution Referrer URL might appear in your Analytics Tool thus hiding the original traffic source.

However, most Analytic Tools are able to minimize this problem.

In case you are using Google Analytics as reporting tool, this step by step guide may help you to

exclude the URLs: .under bullet point 4

http://www.sellxed.com/en/faq
http://www.sellxed.com/en/support
http://www.optimizesmart.com/tracking-true-referrals-in-google-analytics-when-using-paypal-and-other-payment-gateways/
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1.  

2.  

10 Compatibility with Third-Party Plugins
The plugins listed below are compatible with our payment modules and allow you to handle

certain tasks in an easier way.

10.1 Birthday and gender in OpenCart

For certain payment service providers it is necessary to check the birthday and the gender of a

customer. OpenCart does not check this by default.

How to enable gender and birthday checks in your shops checkout

Add two new custom fields to your checkout via your shops backend under 

"Customers > Custom Fields"

Modify the order context getters to return the value of your custom checkout field 

from the order / session (or wherever the previous step saves the data).

Order Context Getters

AbstractOrderContext

getBillingDateOfBirth()

getBillingGender()

These functions can be found in "system/library/cw/FCSolution

/AbstractOrderContext.php".
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11 Error Logging
The module will log different unexpected errors or information depending on the configured

level. If there is any issue with the module, this log can help identify the cause.

11.1 Log Levels

You can configure the log level in the First Cash Solution settings.

Error: Logs unexpected errors only. (Default)

Info: Logs extended information.

Debug: Logs information helpful for debugging.

11.2 Log Location

The log file is stored in the default log folder of OpenCart. The path is configured in the config.php

of your shop system. (Default Path: {shopRootDirectory}/system/logs or {shopRootDirectory}

/system/storage/logs)
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12 Advanced Information
This section of the manual is for advanced usage of the module. The content is for advanced

users with special requirements. Everything in this section is optional and not required for the

daily usage of the module.

12.1 Transaction Object

This section describes how to extract information from a transaction, if you need it for further

processing. E.g. you require more information of the transaction for further processing an order

in your ERP system.

The code snippets in this section assume your script resides in the root folder of the shop with

the default shop folder structure.

In your script initialize the base of OpenCart.

Opencart 3.x

require_once('config.php');

require_once(DIR_SYSTEM . 'startup.php');

// Registry

$registry = new Registry();

// Config

$config = new Config();

$config->load('default');

$config->load('catalog');

$registry->set('config', $config);

$loader = new Loader($registry);

$registry->set('load', $loader);

$registry->set('db', new DB($config->get('db_type'), $config->get

('db_hostname'), $config->get('db_username'), $config->get

('db_password'), $config->get('db_database'), $config->get('db_port')));

Include the module specific files and set registry.

require_once DIR_SYSTEM.'library/cw/init.php';

require_once DIR_SYSTEM.'library/cw/FCSolutionCw/Util.php';

require_once DIR_SYSTEM.'library/cw/FCSolutionCw/Entity/Transaction.php';

FCSolutionCw_Util::setRegistry($registry);

Now you can load the transaction and then extract the transactionObject.

Load the transaction by Id:

$transactionById = FCSolutionCw_Entity_Transaction::loadById

($transactionId);

$transactionObject = $transactionById->getTransactionObject();
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Load transactions by Order ID:

$transactionsByOrderId = FCSolutionCw_Entity_Transaction::

getTransactionsByOrderId($orderId);

foreach($transactionsByOrderId as $transaction){

    $transactionObject = $transaction->getTransactionObject();

    //Do something with each object

}
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